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Open a Recent ltem

WESEJENENERE JENENE.

|

| sample_stteUntitled-2 html

| sample_stelsite html

sample_sitejava.html
Puhblish/Untitled-2 html
PublishAheme_03_design.html
PublishAheme_03...om_template html
Templates/design_template dwt
sample_sitefuntitled htm|
Templates/Untitled-4 cwt

Open...

Getting Started »
Newy Features »
Resources »

Dreamwveaver Exchange »

Don't showy again

Create New
HTML

| ColdFusion
PHP

Top Features (videos)

EH €SS Inspect Mode
| EE CSS EnableDisable

ASP vBScript
HSLT (Entire page)
CSS

JavaScript

XML

SEIEIENERE IENENE]

=
=)

More...

{0

Dw|

Dreamweaver Site...

EE Dynamically-Related Files
EE Live View Navigation
EE BrovvserLab Integration

. More...

Dreamweaver on Adobe TV

To get the latest expert insights and tutorials
on Dreamweaver, visit us on Adobe TV

open recent items  Lila Lgade Jaad ) cililal) b eliSay cua il L& JNA (e

create new s cila i g

top features videos ¢ siig a ) (5 & 3all alad ol

don’t show again (s A 5 e L lghl ade (Sayg

Lailll) (pa Lo Jlgdi) 8 aSal (Say g

Edit->preferences->general -> Show welcome screen
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[T Common L'
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S AR :- o [ T
- 3 €88 STV
Code okt | Oesgn bvecCode L UveVew Jugect z Tele: | Lrttied Cocument
- - . . the: " A s
- R
1.0 Trensiticaal//IN" )" (o styles delred)
sitional, Ota™>
= 1 L3 4
<1'0...«.-
¥k
SR UL -
S s [ASMETS | APEUDMINTS | B
) e W | Locy vew v
. C| 3¢ )
Local Flles el )~
D "0 - oule (C\Docum,
S e r
20D o r
O %orrisets r
6 4 ) Tenglates F
Body> RIS QL 100% v 777xM0« 1K/ 1 eac Unicode UTPL - vatend 2D
B 8 crrmiss w0
< Fomat Nore ~ Cass  Nore v BZ Ezua Tele B o mep2y »2
Bcss 0 None v Lk v - Torget - stetem »5
S Unttied 2 temd -
- B » X
Fage Propertes.... | < - >
§) Resdy Ve

Meﬂ\dﬂj\uhjh“};(5JAMJGAUJJ\UJD\UA.\A‘94 ‘ubﬂ\
daldl) il BN (any g ?4\333\3 @3.4\ iy a5 g Jaadl Aaluwa || The Application bar

gl ) B asailly

laa (DU gl 368l it o) aanaall Lgda g Jaadl dalua il M\um
Workspace swntcher

Design view, Live Jie dadal) JS& it il g8y P =Y M’,‘.’Uﬁ
raial) o dadall a2 £ 9 view, and Code view The Document toolbar

insert o 4waldlldagll o g giadg dlid b asail) b daelud panels 443-‘

2 el il aa Jalailly Aalil) dalll | css o dualdd) daglll
Window Aadldll (e W 5UEA 5 L gl oS g
Aaraal lgd Jaad g g Jand Al daduall jgditg dadual) 328U
document
window

poii Ll g Zoom Jead) 48,9 45 aaa b aSadl] (Say ADIA (e [ i) g Allad) Jay 5
Bsall b LS Ly giSa Bandy dde Jand silitag J) il ]
<body> The Tag -Status bar

selector
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document toolbar Aadall & gl Jay y&

Hz'\?o@ | spit | Design  LiveCode [

12 3

Live View

4

Inspect @), . Title: | Untitled Document a9, |<:

= 6

Categary Preview in Browser
General

Code Coloring
Code Format
Code Hints

Code Rewriting
Copy/Paste

(55 Styles

File Compare

File Types [ Editars
Fonts
Highlighting
Invisible Elements
New Document
Site

Chabie Bay

chrome.exe
firefox.exe

|IExplore  F12

Defaults: [V]Primary browser
[[Jsecondary browser

) ) ]

dasiall 4 dasd o SI) pelad code 1

Z\;ém]\ge:mmﬂ\jajﬂ\)@l& split 2

dasall Alad areaill jeal design 3

bl paldl) miaiall e dsdiall araal a2l Live 4
View

) cabadl 533 5 Al miaiall e dlintin araal (e (e il ) 5
A e Cladiaiall Cada gl Ailia) (S s eali_l e

Edit->prefrences->Preview in browser | zéiall

Preferences

Accessibility ,
AP Elements B E]

Laaalltitle dee title 6

Property inspector

Properties |

il

X O0Y o

B

i e, X g etfaebaipe § ) O fatredProducthat. v W [my
D Ik ¢ oD BRAL NROA B pr]

Map Target v

>

T A Pk oo The

e
=
=
«

daiall Jivd 8 Wi jailad)l s ja aa

paibad @l jelain s ) pa paaty Gl 1) Mk Andiall A& Baaat & 68 (oAl ¢ Jall (ailiad A Jaawill aadid

led Jaaxdll 5 28La™ 5 ) gaall
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saliadl JAa da ot Insert panel -
.“SS :~n_.1 LAS !~.~

Common ¥
Q Hyperlnk )
[=] Email Link
& Named Anchor

== Horizontal Rule

11}

~=| Table

Insert Div Tag

@ ~ Images : Image
é] ~ Media
c ‘Widget

Date [s]

B | Eavi

DR o B @

- Common | Lafout | Fa

|

Common

Jlaally  saall Jie dailall jualiall JA0) 3 addiud
Layout

div J zU e s sind g dndiall aylads aa Jalaill
Spry

A yaiall 2l gl e Jalaill

Form

Contains buttons for creating forms and inserting form elements, such as
search, month, and password.

Favorites
a5 OlSe (8 Lelantnd Sl jnsert 4edall (e ol ga¥) AS) apeaty Sl e

Text
Ul, ol ,h, Jia u.a;...a.\ﬂ.} aalall :\MJY\ & Jalaill
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SiigManagement [ ol o =) ol 5l 3 Sl

L 3 5 A Gl das g ad sall and JLEAY o3 5 new site DU site Al JMA (4

Site Setup for Unnamed

asd hilile

Site

Servers

Version Control

» Advanced Settings

A Dreamweaver site is a collection of all of the files and assets you use in your
website, A Dreamweaver site usually has two parts: a local folder on your
computer where you store and work on files, and a remote folder on a server
where you post the same files to the web.

Here you'll select the local Folder and a name for your Dreamweaver site.

Site Name: m l

Local Site Folder: [ C:\Documents and Settings'q,OmarAmin'v,Desktop‘q,HtmlCourse';] a

I Save I | Cancel ]

40 Aadlil) Cpa a8 gall anal g cildlal) (iSLa) i (S g
Site->manage sites->Edit

=
]

;—EU'B New..,
dreemwavercss .
temp Ed't' .
test
Duplicate
Remove
Export...
_Impoart,..
Done Help
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D culaz | Vl} |Local view [ v_[
R Cl o eYasd| B
Local Files

= Site-cula2 (C:\Docu..,

= HTML Folde

= PHP Foldk

#-IC) Spryassets Folde

#-I) Templates Folde

-T2 java.html SKB Chro

B page_image_1.jpg  32KB PG|

B page_image_2.jpg  13KB PG|

T site.html 10KB Chro

-T2 Untitled-2.html 1KB Chro

T UntitledFrame-S..., 1KE Chra

T UntitledFrameset... 1KEB Chro

T UntitledFrameset. .. 1KB Chro

$ ) m 2]

Use the Files panel to view and manage the files on your Dreamweaver
site.

Site Aalall (1o ad sall cliy pa o) el (Slal dansiy | el ga 8 il 3 )l 5 Jalaiil
Giob 08 s g0 alae (a5l aaa alase ddlia) GliSay

Right click->new folder

—alall

Right click->Edit->delete

B Aadia A8l

Right click->new file

Gk oo dlea Glo adsall Gl 4y )

Right click-> Explore...

| Amin Mahmoud s a2 m




Laa cala gL
b 15 ) ) Sy ol g st 8 g Laniodt 2 L)) Jaia (Sl g o sall sl ity 5 a3 2a
)@.L".Luj new Ju;.:(jﬁle amm‘c;saeﬁ'édghma&ha}(}&)m:\m&\ Oladall L

aallal) ALaLa)

Page Type: Layout:
| Blark Page | =5 HTML <none:
| = HTML template 1 column fixed, centered
‘ : Library item 1 column fixed, centered, header and foot
@ Blank Template = ¥SLT (Entire page) 1 column liquid, centered
S ySLT (Fragment) 1 column liquid, centered, header and foot R—
& == ActionSeript 2 column fixed, left sidebar p
‘Eb Page fiom Template | = . 2 column fixed, left sidebar, header and fc
| D ||
5 = column fixed, right sidebar, header an:
Page from Sample E— i 2 column liquid, left sidebar
™ Asp avaseript 2 column liquid, left sidebar, header and fc
’ Other e s — 2 column liquid, right sidebar T
i p 2 column liquid, right sidebar, header and f
T ASP.NET C#t 3 column fixed
T ASP.NET VB 3 column fixed, header and footer
T ColdFusion | 3 column liquid
": ColdFusion component | | 3 column liquid, header and footer DocType: XHTML 1.0 Transitional ‘v]
T ISP HTMLS: 2 column fixed, right sidebar, heac =
‘f‘_ PHP HTMLS: 3 column fixed, header and footer
Attach €SS file: =
nable InContext Editing
. ’ r Learn more about Business Catalyst
30 T || InContext Editing
[ Help ] [ Preferences... ] Get more content... I Create ] [ Cancel ]

o5& latyout e html oS50l & i 3l caldll ¢ 63 LAl page type (e psdi o
dadiall laplaas sl

html/xhtml/html5 4ssall ¢ 55 U DOCType (< o

uaa 0SS —ala A g head 2 4kds (Sargcss Jbaés (lSa20ai | ayout css e

attach css file W 2 g5iSacss ol Glall Lol (S @

Led Joanll 5 Lgy el i€y 3 s ilaad o el il (5 sim
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LWy File  Edit View Insert Modity Format Commands  Site Window Help | BNy v & v

B 1|Sem|qulm|h1 h2 h3|u| ol Illdl dt dd|ahbrvu3c|—v

Untitled-2.html* >

! Code | spit | Design Live Code  fF=d Live View  Inspect (gi. ‘S Title: | Untitled Document |
© . Address: 1 ts and Sstt ¢ Amin Ciastt op it olea EL‘ 3
152 Doay- Tigs
B @ <ni>hl -
10 </hl>
11 <h2Z>hz&nbsp; </h2>
+e 12 <h3>h3</h3> ‘ ]
> 13 <ol> E
o
15 ]
16
¥ N
= |
I
hl
i
h2
3
1
pPillorderd list
2
<body> <ol> (R 167% O [100% ~ | 777 x 274 1K [ 1 sec Unicode {(UTF-£
PROPERTIES
| €% HTML | Format | Heading 3 ,:f_] Class | mMone \\:ﬁ] B 7 EE!E|§ 2= Title
B3 css ID | Mone e ] Link | ] Lor S Target
Page Properties... List Iteriv

insert 4l (e dauiall text aeilall HUAS 28 Baal g aealll dadia 4 i) US4 g

Al po e 54 ya daild 5l oo jh o) o) () sie Aaad Gailly dadi () 2y 3 13l 22a5

zﬁﬂ\‘;)ku&d}@sw\hjlwenter &Mbeﬁﬁd\d'}bzﬁh\iﬁ

Shift+Enter e baall o i

IR (e dnsiall JAJa AR 5 a5 cala ol yaial (G e Gl JBA (S
File->import->word document

o o) a9 Jadd et CulS 1Y) Ll o) yall Gaill Al 45 formatting s
copy/paste b e 8 il dadall Jaly (o Jla 55 cile (84 6iSe 558 s (Kay
A Aailall i d el Jadil g 3 ol Cale 8 3 sm sall Ganiills i Sy g

Edit->preferences->copy/paste
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L il JAa) -]
w31l gl ) iy yaill JAS) 22
bold /italic Jis osba) Gauity (il JA21 -3
JalS iy il JA0) 4

FPreferences

Category

| General
Accessibility
AP Elements
Code Coloring
Code Format
Code Hints

| €55 Styles

File Compare

File Types [ Editors
Fonts

Highlighting
Invisible Elements
New Document
Preview in Browser
Site

Status Bar
Validator

Code Rewritini

5

Copy/Paste

Edit > Paste from other applications into design view pastes:
(O Text only
(O Text with structure {paragraphs, lists, tables, etc.)
(O Text with structure plus basic formatting (bold, italic)
(%) Text with structure plus Full Formatting (bold, italic, styles)

Retain line breaks
Clean up Word paragraph spacing

-
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html J) dadal LY g Guudll) ALY css J) Jarieny
A a8l B css J il sSag

Selector Declaration Declaration

@ { color:blue; font-size:12px; }

Property Value Property Value

dadal)l Jalacss ) Judl gk GO da g

JC\A Mé\u‘gﬂ Jal . uJJY\
<h1 style=""background-color: red ;"> this Is H1 </h1>

SIS 065 <head> sl Jala ;A0

<head>
<style type=""text/css""> body {background-color: #FF0000;} </style>

</head>
AU html ) daduay 48ali oh o5 daialy i A dadia 8 39S 4K, o 680 ¢ LAY

<link rel=""stylesheet" type=""text/css"" href=""style/style.css" />
href dxaldll 2 dilal) (S daad Eua
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CSS

CSS STYLES | AP ELEMENTS | TAG INSPECTOR

g

All Rules

=] style.css
¥nav
body
#nav ul
#nav ul i S
#navullia
#nav ul li a:hover

Properties for "#nav"

background-c... [] #E2FF389

float right

height 40px 4
text-align center

width 100%

Add Property

= Az}[*+4] Z§ 6\ %

. e
i

b44L

a5l

B
>

all  Aadall b 5aga gall cOLLLY) ran (i 1

Current axalll Aada (e daaal) Ul galdd) Jiba) (i s 2

Laraaly cuad Al dadiall b coliul) gl (a o 3

O B dpald ALl Sy g 3 AELEY (e danal) GGVl dualdl) 2 l) 4
Add Property

Baa css rule  Jas 5

COLLLY) Aaild (pe 3aaaad) ¢SS rule o Jawd Jas 6

gIA (a css il lad) 7

3 AALAY B Bl Aaild a css rule A1) 8

Al ol gladdly 2 685 (e U / Ay o css AdLaY
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W Fle Edit View Insert Modfy Format Commands Site Window Help | Ellv v &~

N &

menu.htmb* X C:\Documents and Settingsiamin|DesktopiDreamwaverimenu. html

AN~ (S e

Properties for "#nav"

—SE
style.css =
= e - - - Al |current
Code Split Design Live Code [ Live View  Inspect i > Title: | Untitled Document
|| Code | split [Desion | | LiveCode | | | Liveview || Inspect | @, @, e | : | 8. T
- © & address: | il Nbaaments and Settngs A Dasktopit 7 E style.css
nav
————— . body
' #nav ul
Aacainll = #nav ulli
-------- P R
Al #nav ulli ahover
il Gilasia
B .

. O #e2FFeg
float right
height 40px
text-align center
width 100%

Add Property

= Azy[aed

FILES

-%ie:

B 6. CS5 Foundations T} 168 pus 2wl eris .o Ps Adobe Photoshop CS... T2 Microsoft PowerPoint ...

new css rule _tas css panel

Selector Type:

@ Ui 2 9| [ocaven ]
Q. ay o P> QQ 3 -4 s &
=i | choose the part you want to add css RcCclee¥aE|B
Local Files [ _size[Type [Modified
& Site - Unnamed Site 2... Folder  06/11j2014 12:57 o
................................................................................................................................................... .5 Templates Folder  28/10j2014 10:0...
| banner2.gif 1KB GIF Image  16/09/2014 10:26 o
9 bacolor.jpg 68KB JPEG Im... 04/11/2014 11:0...
=) h.html 1KB HTML Do... 28/10/2014 10:1...
[B header.jpg 12KB JPEG Im... 08/09/2014 08:04 o
1. k 1 Karnac28.jpg 87KB JPEG Im... 16/09/2013 10:4...
<body> <divitheaders[chiz] C11CK O the tag name (R ] Q [100% +|898x659v 17K/ 1 sec Unicode (UTF-¢ main.css 7KB Cascadin... 27/10/2014 11:1...
PROPERTIES =) menu.html 1KB HTML Do... 06/11j2014 12:52 p
[<>HmL|  Format |Heading 1 v|  Cass [none v B I = = Tee | (8] side.png 4KD PG Image 28/10/2014 1113,
h B style.css 1KB Cascadin... 06/11/2014 12:57 o
B css 1D | None v/ Link | viao Target
. .
@ Ready

EN B ®EEFFG S U 1115 o

(e A css Adlaal Al yall (ausll)e Jadl jlids

A1 AL W e dat

New CSS Rule

Choose a contextual selector type For your CSS rule.

[Class {can apply to any HTML element)

~

J

Selector Name:

Choose or enter a name for your selector.

Specific

Rule Definition:

Choose where yvour rule will be defined.

More Sp

ecific

style.css
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A9 SR Bae e daild gliiu selector type daild (e

Class#
html sais Y ilaly
Id ==
html (e 28 aal 5 paind cilia g
Tag+
html (e G pais paadl
Compound =
araaill dadia b jualinl (e & LER) Guan o
this document 4adwall & css Biaiw Us 13 Rule Definition (s 235 &
ok hiais new stylesheet file s il b gl only

CSS Rule definition for audio m
Cateqgory Type
g;il;(ground Font-Family: | V{
Box e | ) —— i
Border Font-size: ’ v’ [ Font-weight: ‘ VJ
List —— —_—
Positioning Font-style: | v | Font-variant: | v!
Extensions = L ———
Line-height: | vwl p Text-transform: ‘ vj
Text-decoration: [ ]underline Color: || ‘
[Javerline
[Jline-through
[ Iblink
[Tnone

m [ QK ][ Cancel ]
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aiall bphii i tabie J' plasiul
Al @l gadlly o gk daiiall Jals Jgam 7)Y
Insert->table

LdDA e 2083 A0 jelati,

Adlall s columMNs 32ec Y s FOWS o siuall 2ac
table Jsaall ase 5 cell spacing LAY

JuS0900 oS s width

Table X
Rows: IEI Columns:

Table width: |E||:||:| ||pixels Vl

Table size

Hea
11 1
[
[
|| i
Both
Accessibility
Caption:
Surarnar Iy
Help Ik ] [ Cancel
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LIS Jakiai o3 La LAl a 58 LA (e 20e med -
table (< Merge Cells  Juas & (s glalls Caa
Split Cells _lias dailall (i fpa GAUAT) oyl -

Commands  Site  Window  Help | B~ &~ &~

I Text

I ol I |d| dt dd|ahhn wac | BRJ -
Untitled-1*

C§:
a | Inspect | (g (& Title: | Untitled Document | I E
'v All
300 =] |4UD |4SIJ Co0 Co0 E00 (= F00 L0 200 =] 400 950 |1lJlJ —
Do B b I IR e BB e B e BB e B e B e B e B e B e B b B s e S
Table [ Select Table
90'0 Paragraph Format » Merge Cells Chrl+Al+M
Lisk »
Align 3
Font . Insert Raow Ctrl+r
Style , Insert Column Chrl+Shift+a
55 Styles , Insert Rows or Columnns, ..
Templates 3
InConkext Editing 3
Pro
Elemert View »
Edit Tag <table=... 3Shift+F5
Wrap Tag... v Tahble widths
Quick Tag Editor. .. Expanded Tables Mode -
Make Link =
FIL
Create Mew Snippet E’o
]
Cuk
Zopy Lo
Paste ey =
Properties
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JSAIL LaS ddas

AEE-& 00D o B F

paged html*

UV Fe Edt View et Modfy Fomat Conmands Ste Window Hep | By v &~ | CLASSIC »

Code | plt | Design ”| Live Code }Bﬂ' ‘\ Live Yiew || Tnspect | @ @ - ‘ Title: | Untted Cocument: | 1g.

h CS§ STYLES

& o B3 £ address: | file:/[/C|/Documents and Settingsamgad/DesktopfwsaZe|[paget himl

v

AP ELEMENTS

S TAG INSPECTOR

i FILES
B ssers

<E SNIPPETS

‘ 300 302) =

20 210

PROPERTIES

(R )i Q [100% +|1005%520v 33K /1 sec Unicods (UTF+

- Cols Cellspace EI Border EI

E Table Rows W CeIIPadD Align|Center v| EIass|N0ne v|
=

B

e o] 1=
=

Istart 9 UntitedDocu. o Untted-1@6.. |0
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daila Aaild Jand

td Jdid asais 48 406 JBal o) jall ¢ jall aaas

Leud Gailal] 3L o)yl
Al als]

<td width="200" valign="top"

Id=""havside''>

<ul>

<

<

<

1> <a
1> <a

1> <a

</ul>

</td>

href="#"> 4. )l <fa> </li>
ref="#"> W Jail </a> </li>

Nref="#"> Wilaiw </a> </li>
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tag selector J) ¢« td li J) 2wty & 685 Al €55 Jand
list-style-type Jas

#navside ul i {

list-style-type: none;

¥
e 3oAL b g g @ Al csS J) Jars g8

s ¢SS rule Jas 2583 o5 tag selector

CSS Rule definition for #navside ul li a

Category Background
| Type |
] | v n | 1

Bl Background-color: 5] | #8A3F00

Box : I

Border Background-lmage:‘v vjl Browse: .. |

Liskt e

Positioning Background-repeat: \ VJ

Extensions -
Background-attachment: f v}
Background-position (X): f ; ;kl
Background-position (¥): l vil [

| [T] [ OK ] [ Cancel ]
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#navside ul li a {
color: #FECEOQO;
text-decoration: none;
display: block;
background-color: #8A3F00;
text-align: right;
font-size: 36px;

¥

3_ialy b g grhover  p=alall ¢ss J) Jeny a8

aaa €SS rule Jem » 633 &5 tag selector ¢

Duplicate CSS Rule X
eeeeeeeeeeeee
eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee

oooooooo ({based on your selection) ~
Selector Mame:
oooooooooooooooooooooooooooooooooo
lllllllllllllllll R
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